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Preface

Purpose
This document details the installation, configuration, and day-to-day use of the Cisco Support
Tools Server and Cisco Support Tool Nodes.

Audience
This document is intended for System Installers, Administrators, and Users of Cisco Support
Tools 2.4(1).

Organization
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1 About Cisco Support Tools (page 5)
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3 About Support Tools Utilities (page 15)

4 Interactive Mode versus Batch Mode (page 27)

5 About Support Tools Security (page 31)

6 Installing Support Tools (page 35)

7 Configuring Support Tools (page 47)

8 Uninstalling, Reinstalling and Upgrading Support Tools (page 53)
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Related Documentation

Chapter Title and Page

11 Using Cisco Tools from a Command Line (page 115)

12 Using Cisco Common Tools (page 143)

13 Using 3rd Party Common Tools (page 181)

14 Starting and Stopping Support Tools Server/Node Processes (page 237)
15 How to View Support Tools Logs (page 241)

16 IPSec Settings and Procedures (page 243)

17 How to Modify the Login Screen Disclaimer (page 247)

18 How to Confirm the Support Tools Build Number (page 249)

19 Support Tools Troubleshooting (page 253)

Related Documentation

Additional Documents

» Cisco ICM/IPCC Support Tools Tool Release Notes

Conventions

This manual uses the following conventions:

Convention Description

boldface font Boldface font is used to indicate commands,
such as user entries, keys, buttons, and folder
and submenu names. For example:

* Choose Edit > Find.

* Click Finisn.

italic font Italic font is used to indicate the following:

« To introduce a new term. Example: A skill
group is a collection of agents who share
similar skills.

» For emphasis. Example: Do not use the
numerical naming convention.

« A syntax value that the user must replace.
Example: IF (condition, true-value,
false-value)
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Obtaining Documentation, Obtaining Support, and Security Guidelines

Convention

Description

» A book title. Example: See the Cisco CRS
Installation Guide.

window font

Window font, such as Courier, is used for the
following:

» Textas itappears in code or that the window
displays. Example: <html><title>Cisco
Systems, Inc. </title></html>

Angle brackets are used to indicate the
following:

» For arguments where the context does not
allow italic, such as ASCII output.

» A character string that the user enters but
that does not appear on the window such as
a password.

Obtaining Documentation, Obtaining Support, and Security Guidelines

For information on obtaining documentation, obtaining support, providing documentation
feedback, security guidelines, and also recommended aliases and general Cisco documents, see
the monthly What's New in Cisco Product Documentation, which also lists all new and revised

Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/gener al/whatsnew/whatsnew.html
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Key Features

# Chapter 1

About Cisco Support Tools

This chapter contains the following topics:

» Key Features, page 5

« About Support Tools Components, page 7

« About Support Tools Network Topology, page 8
» Frequently Asked Questions, page 8

Cisco Support Tools is an application that contains a suite of utilities that allow you to manage
and troubleshoot servers that run broad range of Cisco Unified product software components.
Through Support Tools, you can troubleshoot configuration and performance problems on these
systems from any machine running a supported version of Windows and Internet Explorer on
your network that can access the Support Tools Server.

Access to utilities in the Support Tools suite is through a browser-based interface--the Support
Tools Dashboard--installed on the Support Tools Server. Levels of security control both access
to the Dashboard and the ability to use specific tools once logged in. In low bandwidth conditions
(for example, via dial-up access) or when Web browsing is otherwise impractical, many Support
Tools utilities can also be accessed and run via command line.

Key Features

The Support Tools suite includes the standard diagnostic tools delivered with many Cisco
Unified products. It also provides key new functionality including the ability to :

» Detect events and alert you to them. The Event Detection tool collects Cisco log messages
and Syslog messages from various processes.

« Interrogate individual Support Tools nodes for their hardware/OS, Cisco component, third
party product information, and application specific data or files.
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Key Features

View, stop, and start services running on Support Tools nodes.

View and terminate processes running on Support Tools nodes.

Performance Monitor.

Compare and synchronize registry settings from different Support Tools nodes.

Pull logs from many Support Tools nodes including the following:

ICM call routers

ICM Loggers

ICM Peripheral Gateways (PGs)

ICM Admin Workstations (AWS)

CTI Object Server (CTIOS)

Cisco Collaboration Server (CCS)

Cisco Unified Contact Center Express (CRS)
Cisco Unified IP IVR (CRS)

Cisco Agent Desktop (CAD)

Cisco Security Agent (CSA)

Cisco Unified Customer Voice Portal (Unified CVP)
Cisco Email Manager (CEM)

Cisco Media Blender (CMB)

Cisco CallManager (CCM)

Create enhanced time-synchronized merged logs across different servers.

Set trace levels trace levels on different applications for a duration of time, then collect logs
against that application.

Run a majority of the tools in either Interactive Mode (where one system is immediately
selected and queried) or Batch Mode (where several systems can be scheduled to be queried
at some point in the future).
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About Support Tools Components

About Support Tools Components

Support Tools uses a client/server architecture to support remote systems running Cisco Unified
application software. The architecture is comprised of the Support Tools Server and the Support
Tools Node. The server and node connect using TCP/IP and can exchange large volumes of
messages with only a minimal impact to system performance.

The Support Tools Server

The Support Tools Server must be installed on a system that has little or no performance load,
namely a standalone network workstation or a client ICM Admin Workstation (AW). The
Support Tools Server can be installed on multiple systems to provide multiple access paths.

Major features of the Support Tools Server include:

» The Support Tools Dashboard, a browser-based interface that allows access to all Support
Tools utilities.

» Web Tools-- a set of system management utilities specifically designed for use with Support
Tools.

» The Support Tools Repository, a central storage location for history files (for example, logs,
registries, etc.) gathered and saved through the Support Tools Dashboard. These files can be
downloaded, viewed, and used for system comparison or restoration. Note that multiple
installations of the Support Tools Server do not share a common repository--each will maintain
its own instance.

The Support Tools Node

The Support Tools Node serves as the client to the Support Tools Server. It is installed on each
Cisco Unified product to be managed through Support Tools.

Major features of the Support Tools Node include:

« The Node Agent Service, used to accept connections from the Support Tools Server.

« Command-line versions of most Support Tools utilities, allowing these tools to be run from
a node when access to the Support Tools Server is unavailable or otherwise impractical (for
example, during a network outage).

« A local Repository used to store saved and downloaded files when Support Tools utilities

are run directly from a node (via a command line) outside of the Dashboard interface.

Note: The Support Tools Server installation automatically installs the Node Agent Service to
the Support Tools Server, ensuring that this system can also be managed through Support Tools.
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About Support Tools Network Topology

About Support Tools Network Topology

The Support Tools Server is installed on a standalone server or a client ICM Admin Workstation
in your network. To ensure redundancy, the Support Tools Server can be installed on multiple
systems. Note however, these multiple installations do not have the ability to share data with
one another.

The Support Tools Server can communicate with Support Tools nodes through a firewall provided
the appropriate portson the firewall have been opened.

User access to Support Tools is limited to your network. Remote users wishing to use the Support
Tools Dashboard must first connect to the network--remote access via the Internet is not
supported.

The following diagram shows Support Tools deployed in a basic IPCC network.

Figure 1: Support Tools Topology Diagram
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Frequently Asked Questions

This section gives brief answers some to some common questions about Support Tools. All of
the subjects addressed here are described in greater detail elsewhere in this guide.

What isthe benefit of Support Tools?

Support Tools provides a common interface (the Support Tools Dashboard) to a suite of utilities
you can use to examine and troubleshoot Cisco Unified software products.

What components make up Support Tools?
The Support Tools Server provides the engine and interface through which users access Support
Tools utilities. The Support Tools Node is the listening agent that allows the Support Tools

Server to interact with Cisco Unified software components.

Wheredo | install the Support Tools Server?
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Frequently Asked Questions

The Support Tools Server can be installed on a client ICM Admin Workstation (AW) or on its
own dedicated machine. Do not install the Support Tools Server on an AW Distributor or any
other Cisco Unified software component server other than an ICM client AW.

Wheredo | install the Support Tools node?

The Support Tools node should be installed on each supported Cisco Unified software server
that you want to manage with Support Tools. See About Support Tools Platforms for a complete
list of supported components.

What performanceimpact will running Support Tools have on my Cisco Unified system?
Support Tools processes run silently with minimum performance impact.
Note the following with performance in mind:

« Installing the Support Tools Server on its on its own dedicated machine reduces any
performance impact that might be imposed if it were collocated with an ICM client AW.

» Because of the possible need to reboot, the Support Tools node should be installed during
an off-production maintenance period. Rebooting Cisco Unified software components can
cause a loss of service or product functionality.

« Large log collections should be performed at times of low network traffic. Large collections
can a spike in bandwidth usage on the system.

» The Support Tools Repository and its subdirectories should be excluded from continuous
virus scans.
Who can use Support Tools?

Any Cisco Unified user can use Support Tools with the proper permissions can use Support
Tools. Permissions can be set to limit access to certain sensitive utilities in the Support Tools
Dashboard to a privileged group.

What configur ation does Support Toolsrequire after installation?

While some optional configuration is available (see the Configuring Support Tools section) no
post-installation configuration is required to use Support Tools out of the box.

Note: To use Support Tools' merged log capabilities, each Support Tools Server and node must
be able to communicate with the same Simple Network Time Protocol (SNTP or NTP) server.
See How to Collect Information for a Support Tools Installation for more information.
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Frequently Asked Questions
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# Chapter 2

Support Tools Requirements and Compatibility

This chapter contains the following topics:

Support Tools Node Requirements, page 11

Support Tools Server Requirements, page 12

Support Tools Server / Node Version Compatibility, page 13
Support Tools Port Requirements, page 13

Support Tools Dashboard Web Browser Requirements, page 14

Support Tools Node Requirements

Support Tools Node Compatibility with Cisco Unified Products and Product Components

The Support Tools Node can be installed on the Cisco Unified components listed below:

Cisco Unified Product or Supported Versions Supported Components
Solution

Cisco Intelligent Contact 4.6(2) and above All
Management (ICM) and IP

Contact Center (IPCC) Enterprise

and Hosted

Cisco CallManager (CCM) 3.X, 4.X All
CTI Object Server (CTIOS) 4.6(2) and above All
Cisco Unified Contact Center 4.0 and above All
Express (CRS) (formerly IPCC

Express)

Cisco Unified IP IVR (CRS) 4.0 and above All
Cisco Agent Desktop (CAD) 4.6(0) and above All
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Support Tools Server Requirements

Cisco Unified Product or Supported Versions Supported Components
Solution

Cisco Unified Customer Voice |2.1 and above All

Portal (Unified CVP) (formerly

ISN)

Cisco Collaboration Server (CCS) |5.x All

Cisco E-Mail Manager (CEM) [5.x All

Cisco Media Blender (CMB) 5.X All

Support Tools Node Hardware Requirements

The hardware requirements for the Support Tools Node are predetermined by the Cisco Unified
software component on which it runs.

The Support Tools Node installation requires a minimum of 20 Mb of available disk space.

Disk space required for log storage is proportional to the number of logs collected and stored.
100 Mb of available disk space is recommended.

Support Tools Node Software Requirements

The software requirements for the Support Tools Node are predetermined by the Cisco Unified
software component on which it runs.

Support Tools Server Requirements

Support Tools Server Hardware Requirements

You can install the Support Tools Server on a standalone server (that is, one on which no Cisco
Unified products are installed), or on an existing ICM Admin Workstation (AW) in your ICM
network. Collocation of the Support Tools Server on other Cisco Unified software product
component is not supported.

Warning: Due to possible performanceissues, do not install the Support Tools Server on
an ICM distributor AW; AW installation should be limited to client AWSs.

The Support Tools Server can be installed on these hardware platforms:
» MCS-10-004-Class
» MCS-10-003-Class
» MCS-10-002-Class

* MCS-10-001-Class
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Support Tools Server / Node Version Compatibility
Additional hardware requirements include:
» ATA/IDE acceptable

 Graphics card capable of 1024 x 768 x 64K color or better (17" or larger display
recommended)

» Disk Space: The Support Tools Server installation uses approximately 100 Mb of disk space.

Additional space requirements will depend on the size and quantity of files retained in the
Repository at a given time. For typical use, 1 Gb of available disk space is sufficient.

Support Tools Server OS Requirements

Prior to installing the Support Tools Server, one of the following operating systems must be
installed and properly configured:

« Microsoft Windows XP Professional with Service Pack 2
« Microsoft Windows 2000 Server with Service Pack 4

« Microsoft Windows 2003 Server Standard Edition with Service Pack 1

Support Tools Server Network Requirements

Ensure that the machine on which you will be installing Support Tools Server has network
access and administration rights to each Cisco Unified software component on which the Support
Tools Node will be installed.

Support Tools Server / Node Version Compatibility

The Support Tools 2.4(1) Server is backwards compatible with previous versions of the Support
Tools Node. The Support Tools 2.4(1) Node is backwards compatible with previous versions
of the Support Tools Server. Note, however, that 2.4(1) functionality will not be available when
working with earlier versions of the Support Tools Nodes or Server.

Support Tools Port Requirements

Support Tools has the following port requirements
» Support Tools HTTP Server (Tomcat) HTTP and HTTPS Port (page 14)

 Support Tools Listening Port (page 14)
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Support Tools Dashboard Web Browser Requirements

Support Tools HTTP Server (Tomcat) HTTP and HTTPS Port

Cisco CCBU Support Tools HTTP Server (Tomcat) bundled with Support Tools by default
listens for HTTP requests on port 8188 and HTTPS requests on port 8189. These defaults can
be changed at installation, if desired.

If a firewall stands between the Support Tools Server and any Support Tools node, and/or
between the Support Tools Server and remote users, you must open these ports on the firewall.

Note: Enabling the HTTPS port on a firewall is necessary when using Support Tools in the
default HTTPS mode.

Support Tools Listening Port

Support Tools requires a port to initiate connections with and listen for responses between the
Support Tools Server and Support Tools Nodes. By default, the Support Tools Server uses port
39100. As desired, you can specify a different port during installation.

As part of the Support Tools installation/configuration:

» Ensure that the port used by the Support Tools Server is available on the supported Cisco
Unified software products it manages.

« |f afirewall stands between the Support Tools Server and any of its ICM or related Cisco
Product Nodes, you must open the listening port on the firewall.

« All servers and nodes must use the same listening port. If you change the default port it must
be changed on the server and all nodes.

Support Tools Dashboard Web Browser Requirements

Access to the Support Tools Dashboard requires Internet Explorer 6.0 Service Pack 1 or greater.
No other browser types are supported.

Warning: Whilenon-supported browser smay appear towork, irregular resultscan result
from their use.
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About Support Tools Utilities

This chapter contains the following topics:

» Support Tools Utilities List, page 15
 Privileged Utilities, page 24

« Utility Installation Locations, page 25

« Non-Dashboard Utilities, page 25

« Command-Line vs GUI Access, page 25

Support Tools Utilities List

Support Tools includes a suite of utilities to monitor, administer, and configure Cisco Unified
software components on which the Support Tools Node is installed. Utilities are grouped into
these categories:

« Support Web Tools (page 16) includingTrace and Log Tools (page 17): Event Detection
and Alert tool, System Interrogate, Registry, Registry Compare, Processes, Services, Trace,
Log, and performance monitor tools, available in both Interactive Mode and Batch Mode.

« Cisco Common Tools (page 17): Pre-existing Cisco utilities which in most cases already
exist on supported Cisco Unified software products as part of a standard installation.

« 3rd Party Common Tools (page 19): Bundled third-party Windows, DOS, and Unix utilities.
Windows and DOS utilities will already exist on supported Cisco Unified software products
as part of a standard Windows installation. Unix utilities are installed as part of the Support
Tools node installation.
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Support Tools Utilities List

Web Tools

The following utilities were created by Cisco specifically for use with Support Tools. They can
be run from within the Dashboard interface or from an external command line on either the

Support Tools Server or an individual node.

Tool Name: |Description: Installed On: Dashboard |External
Privileged |GUI--No
Users Dashboard or
Only: Command-Line
Access:
Reqgistry Use to view ICM or related | All Windows-based | X

Cisco Product registry

Support Tools

entries. nodes
Registry Use to compare and All Windows-based| X
Compare synchronize ICM or related |Support Tools
Cisco Product registry nodes
entries.
System Use to display system All Windows-based
Interrogate |information (for example, |Support Tools
OS, hardware, ICM, SQL). |nodes
Processes  |Use to view and stop All Windows-based| X
Processes running on an ICM | Support Tools
or related Cisco Product. nodes
Services Use to view and stop All Windows-based | X
Services running on an ICM |Support Tools
or related Cisco Product. nodes
Performance |Use to collect and monitor | All Windows-based | X
Monitor performance log files. Support Tools
nodes
Event Use to select the events to | All Windows-based | X
Detection  |which you want to be alerted. | Support Tools
and Alert  |Allows you to configure nodes

email destination for the alert
notification. Also allows you
to enable/disable the alert
tool, email alert capability,
and clear the alert.
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Support Tools Utilities List

Trace and Log Tools
Support Tools features enhanced logging capabilities including the ability to set trace levels
based on existing log groups.

Utility Name: Description: Installed On: Dashboard

Privileged Users
Only:

Create Log Group

Ability to group a set of servers, products,
and processes for which to collect logs.

All Support Tools nodes

Create Trace group

The ability to set trace levels for a log

All Support Tools nodes

group.
Schedule Trace Schedule the changing of trace levels. All Support Tools nodes X
Collect Logs Collect and view log files from ICM and | All Support Tools nodes X
related Cisco products.
Cisco Common Tools
The following Support Tools utilities were created by Cisco specifically for use with ICM. Most
can be run both from within the Dashboard interface, or from an external command line.
Tool Name: | Description: Installed On: Dashboard |External
Privileged |GUI--No
Users Dashboard or
Only: Command-Line
Access:
cicman Use on a NAM CallRouter to view and set NAM |NAM Call Routers
to CICM session information.
ctitest Use for debugging or demonstration in a Cisco ICM|CTIOS PGs X
CTI environment. Can be used in place of an
Interactive CTI client application.
dbdiff Third-party (Microsoft) tool to compare database [Nodes on which SQL
tables. Invoked with the diffconfig.bat tool. Server is installed
dumpcfg Dump Config ICM audit utility. Use to analyze the | Loggers (but can be
ICM Config_Message_Log table. Allows you to |run from any ICM
determine WHO did WHAT, WHEN, from component)
WHERE, using WHICH program.
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Support Tools Utilities List

new style NT SS7 NIC PG.

Tool Name: | Description: Installed On: Dashboard |External
Privileged |GUI--No
Users Dashboard or
Only: Command-Line
Access:
icmdba ICM Database Administration tool. Use to create, |[AWS, Loggers (ICM | X X
monitor, and edit ICM databases, including Logger, |components with DBs)
HDS, and AWDB databases. ICMDBA is also used
to manage various SQL Server operating
parameters.
mptrace Use to provide a playback from the Nortel Meridian|MerPim PGs
Automatic Call Distributor (ACD) to troubleshoot
potential issues.
nicroi NIC Remote Operator Interface. Use to configure |Routers for customers | X
and debug the (old-style DOS-based) AT&T NIC. |runningan AT&T NIC
Often invoked with the NIC.BAT batch program.
nmstart Node Manager Start. Use to start an ICM service |AWSs, PGs, Call X
on a CallRouter, Logger, AW, or PG. Routers, Loggers
nmstop Node Manager Stop. Use to stop an ICM Service |AWSs, PGs, Call X
on a CallRouter, Logger, AW, or PG. Routers, Loggers
opctest Use to interpret a Peripheral Gateways (PG) status, |PGs X
statistics, etc. It is also possible to enable specific
debug tracing in the OPC process.
procmon General-purpose debugging tool. Can be used in |PGs, Call Routers X
conjunction with various Network Interface
Controller (NIC) and Peripheral Interface Manager
(PIM) processes. Use to verify status, set debug
trace bits, etc.
rtrtrace Use to set various debug tracing on a CallRouter. |Call Routers X X
The additional tracing is output to the .EMS log
files, and viewed with the Trace and Log utilities.
rttest Use to interpret a Call Router's events and states | Call Routers (but can | X
live without interruption to the running router be run from any ICM
processes. Rttest has several subroutines that allow|component)
viewing status, statistics, etc. It is also possible to
enable specific debug tracing in the call router.
ss7nictrace |Use to view and set various debug trace bitsona |PGs X X
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Support Tools Utilities List

Tool Name: | Description: Installed On: Dashboard |External
Privileged |GUI--No
Users Dashboard or
Only: Command-Line
Access:
vrutrace Use to output tracing information from a \oice VRU PGs

Response Unit (VRU) device and to and from its

PIM process. VRUTrace allows capture and
playback of session data.

3rd Party Common Tools

The following Support Tools utilities are bundled third-party Windows, DOS, and Unix utilities.
Most can be run both from within the Dashboard interface, or from an external command line.

files.

nodes

Tool Name: Description: Installed On: Dashboard|No Dashboard
Privileged |or
Users Command-Line
Only: Access:
Arp-a Use to find the media access control address |All Support Tools
of a host on the same physical network. nodes
cat Use the CAT utility to display, print, and All Support Tools X
combine files. Equivalent of the DOS type  |nodes
command.
chmod Use to change file permissions. Equivalent of | All Support Tools X
the DOS attrib command. nodes
cp Equivalent of the DOS copy command. All Support Tools X
nodes
df Use to view disk free information. All Support Tools
nodes
diff Use to compare two text files or two All Support Tools
directories. nodes
du Use to view disk usage information. All Support Tools
nodes
fgrep Use to search for text patterns within a set of |All Support Tools
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Support Tools Utilities List

Tool Name: Description: Installed On: Dashboard |No Dashboard
Privileged |or
Users Command-Line
Only: Access:
findstr Use to find strings in logs or text files. Similar | All Support Tools
to UNIX's grep command. Useful when nodes
parsing log files or other text files to find a
snippet of text.
grep Use to search for text patterns within a set of | All Support Tools
files. nodes
head Use to view user-defined number of lines from | All Support Tools
the start of a file. nodes
IPConfig -all Use to get host computer configuration All Support Tools
information, including the IP address, subnet |nodes
mask, and default gateway.
isql/w Interactive SQL for Windows. Use to query |Nodes on which SQL X
and update Microsoft SQL Server databases. | Server is installed
Is Use to view directory listings. Equivalent of |All Support Tools
the DOS dir command. nodes
mv Use to move files and directories. Equivalent |All Support Tools X
of the DOS move or rename command. nodes
NBTStat Use to troubleshoot NetBIOS name resolution|All Support Tools
problems. nodes
Net Session Use to view information about all current All Support Tools
client sessions with the current system. nodes
NetStat Use to view network information for the All Support Tools

current system, including protocol statistics
and current TCP/IP network connections.

nodes

Net Statistics
Server

Use to view statistics for the local Server
service.

All Support Tools
nodes

Net Statistics
Works

Use to view statistics for the local Workstation
service.

All Support Tools
nodes

NSLookup

Use to get the IP address and fully qualified
DNS of the current system's DNS name servetr.

All Support Tools
nodes
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Support Tools Utilities List

Tool Name: Description: Installed On: Dashboard |No Dashboard
Privileged |or
Users Command-Line
Only: Access:
PathPing A route tracing tool that combines features of| All Support Tools
the ping and tracert commands with additional | nodes
information.
ping Low-level connectivity test. Use to verify All Support Tools
end-to-end TCP/IP network infrastructure.  |nodes
pstat Use to list all NT or Win2K processes, their |All Support Tools
process ID (PID), memory and cpu utilization, |nodes
etc.
rm Use to delete files and directories. Equivalent | All Support Tools X
of the DOS delete, recursive del subdirectories|nodes
commands.
Route-print Use to view the contents of the network All Support Tools
routing tables. nodes
shutdown Use to shut down a remote host. When used |All Support Tools X
from the Dashboard, shutdown will nodes
automatically restart the host after 60 seconds.
sqlew SQL Enterprise Manager. Use to monitor and | Nodes on which SQL X
update SQL Server operating parameters, Server is installed
expand databases, etc.
stopshut Use to stop a system from shutting down due|All Support Tools X
to an application or operating system failure. |nodes
strings Use to find printable strings in a binary file. |All Support Tools
nodes
tail Use to view user-defined number of lines from | All Support Tools
end of a file. nodes
touch Use to change the creation date/time for any |All Support Tools X
file. nodes
tracert Related to ping command. Use to show each |All Support Tools

intermediary Hop in the TCP/IP network.
Useful in troubleshooting LAN and WAN
faults.

nodes
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Support Tools Utilities List

Tool Name: Description: Installed On: Dashboard |No Dashboard
Privileged |or
Users Command-Line
Only: Access:
wc Use to view a count of characters, words, or |All Support Tools
lines in afile. nodes
which Use to view the name of the first file All Support Tools
encountered while traversing a path or nodes
directory tree.
winmsd Windows Diagnostics. Use to gather detailed | All Support Tools X
configuration information about computers |nodes
running Windows.
NetshDump Allows you to run the NetShell utility to All Support Tools
display or modify the configuration of a nodes
currently running computer.
Bootcfggry Queries Boot.ini file settings. All Support Tools
nodes
Defraganalyze |Analyzes boot files, data files, and folders on | All Support Tools X
local volumes for fragmentation. nodes
Defragreport Reports fragmentation of boot files, data files, | All Support Tools
and folders on local volumes. nodes
Driverquery Displays a list of all installed device drivers |All Support Tools
and their properties. nodes
Eventtriggers Displays and configures event triggers on local | All Support Tools X
or remote machines. nodes
Getmac Returns the media access control (MAC) All Support Tools
address and list of network protocols nodes
associated with each address for all network
cards in each computer, either locally or across
a network.
Logman Manages and schedules performance counter |All Support Tools
and event trace log collections on local and |nodes
remote systems.
Openfiles Queries or displays open files. Also queries, |All Support Tools X

displays, or disconnects files opened by
network users.

nodes
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Support Tools Utilities List

Tool Name:

Description:

Installed On:

Dashboard
Privileged
Users
Only:

No Dashboard
or
Command-Line
Access:

Relog

Extracts performance counters from
performance counter logs into other formats,
such as text-TSV (for tab-delimited text),
text-CSV (for comma-delimited text),
binary-BIN, or SQL.

All Support Tools
nodes

SC

Communicates with the Service Controller
and installed services. SC.exe retrieves and
sets control information about services.

All Support Tools
nodes

Schtasks

Schedules commands and programs to run
periodically or at a specific time. Adds and
removes tasks from the schedule, starts and
stops tasks on demand, and displays and
changes scheduled tasks.

All Support Tools
nodes

SysteminfoTable

Displays detailed configuration information
about a computer and its operating system,
including operating system configuration,
security information, product ID, and hardware
properties, such as RAM, disk space, and
network cards.

All Support Tools
nodes

SysteminfoL st

Displays detailed configuration information
about a computer and its operating system,
including operating system configuration,
security information, product ID, and hardware
properties, such as RAM, disk space, and
network cards.

All Support Tools
nodes

SysteminfoCSV

Displays detailed configuration information
about a computer and its operating system,
including operating system configuration,
security information, product 1D, and hardware
properties, such as RAM, disk space, and
network cards.

All Support Tools
nodes

Taskkill

Ends one or more tasks or processes. Processes
can be killed by process ID or image name.

All Support Tools
nodes

TasklistTable

Displays a list of applications and services
with their Process ID (PID) for all tasks
running on either a local or a remote computer.

All Support Tools
nodes
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Privileged Utilities

Tool Name: Description: Installed On: Dashboard |No Dashboard
Privileged |or
Users Command-Line
Only: Access:
Tasklist Displays a list of applications and services |All Support Tools
with their Process ID (PID) for all tasks nodes
running on either a local or a remote computer.
TasklistCSV Displays a list of applications and services |All Support Tools

with their Process ID (PID) for all tasks
running on either a local or a remote computer.

nodes

Privileged Utilities

Some utilities, when accessed through the Support Tools Dashboard, can only be used by
members of the Support Tools privileged user group. If you are not a member of the privileged
user group, these utilities will not appear on the Support Tools Dashboard menu. These utilities

include:

o ctitest

+ icmdba
* nicroi

e nmstart
e nmstop
e procmon
* registry
e registry compare
* rttest
 shutdown
* upcctest
¢ processes

services

Note: These privilege levels only apply to utilities when accessed through the Dashboard; they
do not preclude users from running any utility through an independent command line on a node.
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Utility Installation Locations

Utility Installation Locations

Support Tools utilities exist and can be run from individual supported Cisco Unified software
products (note that the Support Tools Server is itself treated as a Support Tools node). When
you run one of these utilities through the Support Tools Dashboard, you are actually running
the utility remotely on the currently selected node.

Not every utility is installed on every node. For the most part, Cisco Common Tools are installed
on core ICM components only: AWSs, PGs, Call Routers, and Loggers. For example, CICMan
is not present on Unified CVP boxes. See the table in the next section for more information.

If you attempt to launch a utility that is not present on the current system, the Support Tools
Dashboard returns a message stating that the command is not recognized.

Non-Dashboard Utilities

Certain ICM and third-party utilities are only available for use through their own GUI; they
have no command line access. This also precludes the ability to launch and run these utilities
from the Support Tools Dashboard. Note that while these utilities are listed on the Dashboard
menu, they cannot in fact be run from there.

These utilities include:

+ icmdba

o isgl/w

e rtrtrace

o sglew

e ss7nictrace

e winmsd

Command-Line vs GUI Access

For users who prefer command-lines to GUIs, many Support Tools utilities can also be run from
an independent command line. For more information, see the instructions for individual utilities.

Also note that certain utilities (see Non-Dashboard Utilities above) have no command line
access. Additionally, trace does not have a command line utility. Some interrogate features
are not supported via the command line interface, specifically the ability to download captured
files.
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Command-Line vs GUI Access
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Interactive Mode versus Batch Mode

# Chapter 4

This chapter contains the following topics:

About Interactive and Batch Mode, page 27
Working in Interactive Mode, page 27
Working in Batch Mode, page 28

About Pending Jobs, page 28

About Interactive and Batch Mode

Support Tools supports two primary modes of operation; | nter active M odewhich is the standard
mode to use when querying a single system, and Batch M odewhich allows you to query several
systems at a time for any of the specific tools.

I nteractive M ode immediately operates on the currently selected system.

Batch M ode allows you to schedule jobs for multiple systems at any point in the future.

Working in Interactive Mode

Using interactive mode simply involves selecting the system that you want to query using the
Select System tool, then using any of the tools that fall under the | nteractive M ode menu.

For some tools, such as System Interrogate, more detail is available in Interactive Mode because
the support tools server first queries the selected system to determine the additional types of
information that can be retrieved and presents these choices to the user. Whereas in batch mode
this cannot be done since several systems of different node types may be queried during a batch
mode process, and there is no user-intervention to select specific results from a server query.
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Working in Batch Mode

Working in Batch Mode

Batch M odeallows you to query several servers at once by scheduling a tool to run at any time
in the future.

Using Tools in Batch Mode

Step 1

Step 2

Step 3

Step 4

Step 5

To use a tool in batch mode:

Select a tool to use that is within the Batch M ode menu.

Schedule a time to run the tool. Enter a Date and Time using the calendar at the top of the page
for the selected Batch Mode tool.

Note: You must select a time in the future.

Check the select boxes next to the Systems on which you want use this tool.
Click Schedule to schedule the Batch Mode operation.

A page appears confirming that the batch job has been scheduled.

Click OK.

You are returned to the Batch Mode scheduling screen for the selected tool.

Note:

 You can view the results of batch mode operations for any given tool by selecting History
under that tool in the Batch M ode node of the Support Tools menu.

 You can view Pending Jobs for any given Batch Mode tool by selecting the Pending Jobs
node under that tool in the Batch Mode node of the Support Tools menu.

» A separate batch job is created in the Pending list for each system that is selected.

About Pending Jobs

The Pending Jobs screen displays a list of jobs that are scheduled to run for the selected Batch
Mode tool.

You can click Refresh at any time to see if any new jobs have been scheduled or started.

Note: If you schedule a job in the short future (~ 2 minutes) then the job may not appear in the
Pending Jobs prior to its execution.
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About Pending Jobs

Canceling a Batch Mode Job

You can cancel any pending job for a batch mode tool. To cancel a pending job:

Step 1 Check the select box(es) next to the scheduled time of a pending job.
Step 2 Click Cancdl.

A confirmation dialog box appears.
Step 3 Click OK in the confirmation dialog box.

Step 4 Click OK to return to the Pending Jobs screen.
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About Pending Jobs
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About Support Tools Security

This chapter contains the following topics:

» Support Tools Security Features, page 31
» Using IP Security with Support Tools, page 32

Support Tools Security Features

Support Tools operates with the following security features/restrictions:

1. Access to Support Tools is limited to the local network. Remote access via the Internet is
not supported. Users must authenticate against the network in order to use Support Tools.

2. Users must login to the Support Tools Dashboard using their network ID and password,
or the ID and password of a valid Windows account.

Note: The Support Tools Login page uses SSL by default so that user passwords and all
communication between the server and the web client are encrypted and secure.

3. Within the Support Tools Dashboard, access to specific utilities is determined by Windows
User Group membership. Only members of the user group designated as the Support Tools
privileged group can use utilities capable of system modification from the Dashboard.
Non-privileged users are limited to information gathering functionality only. Note that
Support Tools utilities used outside of the Dashboard environment (hamely, via
command-line) do not impose these levels of privilege.

The use of Support Tools utilities outside of the Dashboard environment (accessed via
command line interface on a node) is not controlled by a login/password. System
administrators can use Windows privileges to limit this method of access to specific users
or groups.

4. Optionally, to enhance security, on Windows 2003 systems, you can use Support Tools'
automated deployment of IP Security to authenticate requests from the Support Tools
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Using IP Security with Support Tools

Server to a node. Automated IPSec setup is not available on non-Windows 2003 systems,
but IPSec can be configured manually, if desired.

Using IP Security with Support Tools

Optionally, you can use IP Security to secure communication between the Support Tools Server
and Support Tools Nodes. Authentication occurs at the Node when the Support Tools Server
makes a request. As such, an IPSec-secured Support Tools Server can make requests to an
unsecured Node, but a secured node will not accept requests from an unsecured server.

The Support Tools Server uses a client-policy with a filter that requests security. The Support
Tools Node uses a client-policy that requires security. The filter does not monitor one-to-one
connections. Instead, the filter monitors all incoming IP traffic that uses the default Support
Tools TCP Port (39100). The Support Tools Server, by requesting but not requiring IPSEC
from each Node, does not deny traffic from a Node that is unable to use IPSEC.

Support Tools uses the ESP protocol (Encapsulating Security Payload) for authentication but
does not use encryption. ESP is used to authenticate instead of the AH protocol (Authentication
Header) for the ability to support NAT.

Support Tools uses SHAL for the integrity algorithm in ESP. The policy uses preshared keys.
This topic includes the following two subtopics:

» Automated IPSec Implementation (page 32)

» Manual IPSec Implementation (page 33)

Automated IPSec Implementation

On Windows 2003 Server machines, Support Tools gives you the option of using an automated
implementation of IPSec.

Support Tools implements IPSec as follows:

» You specify the IPSec preshared authentication key to use during Support Tools Server and
Node installation. Keys are case-sensitive and limited to 256 characters. Any character except
single and double quotation marks, back slash, and pipe can be used.

Note: For Cisco Unified products that include a bundled install of the Support Tools Node
(e.g., Unified CVP 4.0), leaving the IP Shared Key value unspecified during installation may
cause Support Tools to install disabled. When this occurs, to enable the node you must
manually start the Node Agent Service on the target machine.

» Authentication occurs at the Node when the Support Tools Server makes a request. As such,
an IPSec-secured Support Tools Server can make requests to an unsecured Node, but a secured
node will not accept requests from an unsecured server.
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Using IP Security with Support Tools

» During installation, Support Tools only prompts for a preshared key when a security policy
can be created and assigned. Support Tools creates a security policies subject to these
conditions:

— If a Cisco policy already exists on the target machine (whether assigned or not) Support
Tools will not create a new policy.

— If anon-Cisco policy already exists on the target machine and is assigned, Support Tools
will not create or assign a Cisco policy.

— If anon-Cisco policy already exists on the target machine and is not assigned, Support
Tools will create and assign a Cisco policy.

Manual IPSec Implementation

On Windows 2000 and XP platforms, IPSec can be used but must be configured manually. This
section provides guidelines on setting up IPSec for Support Tools.

When configuring Support Tools to use IPSec:
» The policy for the Support Tools server should be configured to support shared keys.

A filter should be added complying with the above listed recommendations when securing
a Support Tools component that resides on a system with a one-to-one IPSEC policy. The
filter should be added to the filter list of the existing policy and listed second.

A configuration example follows:

Client Policy
IP Filter
Fromany | P address / TCP port
To any | P address / specific TCP port (39100, Support Tools default)
Filter Action
Request Security on Support Tools Server
Require Security on Node Agent
Negoti ate security
ESP with SHALl Integrity and no encryption
Aut henti cati on Mbde (Both should be |isted on Support Tools server)
Preshared key
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Using IP Security with Support Tools
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# Chapter 6

Installing Support Tools

This chapter contains the following topics:

« About Installing Support Tools, page 35

» How to Collect Information for Support Tools Installation, page 38

» How to Create Support Tools User Groups, page 39

» How to Prepare the Distinguished User Account, page 40

« How to Install the Support Tools Server, page 41

» Support Tools Server and Cisco Unified Customer Voice Portal Operations Console
Co-Residency, page 43

« How to Install the Support Tools Node, page 43

» How to Test the Support Tools Installation, page 45

About Installing Support Tools

Installing Support Tools consists of:
1. Installing the Support Tools Server to a central server with access to your ICM system.
Optionally, you can install the Support Tools Server on multiple servers to provide multiple
access paths. Note, however, that data is not shared between these separate installations.

Note: The Node is automatically included in the Support Tools Server installation; a
separate installation of the node on this machine is not required.

2. Installing the Support Tools Node on each ICM or related Cisco Product to be managed
from the Support Tools Dashboard.
This topic includes the following subtopics:
» Support Tools Installation Tasks (page 36)

» Post-Installation Configuration (page 37)
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About Installing Support Tools

Support Tools Installation Tasks

To install Support Tools, follow the sequence of steps in the checklist below. Each of these
steps is described in greater detail in following sections. Review this list before proceeding with
the installation.

Note: Before proceeding with installation, also be sure to review the Support Tools Release
Notes for any updates pertaining to Support Tools installation. The Release Notes are available
at the top level of the Support Tools CD and at _http://www.cisco.com.

Warning: In someinstances, the Support Tools Server and Node installation may require
areboot to complete. For thisreason, you should perform theinstallation duringaregular
maintenance period when the machineisin off-production mode.

Table 1: Steps for Installing Support Tools

Collect information for the install (page 38).

Prior to installing Support Tools, collect the information that you will need to provide during the install.

Create the Support Tools privileged user group (page 40).

Create and assign users to the Windows user group that will serve as the Support Tools privileged user group.

Create the Distinguished User Account (page 40)

The Support Tools Server installs the Tomcat Web server which runs as a service called "Cisco CCBU Support Tools
HTTP Server." This service must run as a distinguished user. To do this:

1. Prior to installing the Support Tools Server, create the Distinguished User account.

2. After installing the Support Tools Server, assign the Distinguished User the requisite directory privileges.

Review the Support Tools Server hardware and software prerequisites

Prior to installing the Support Tools Server, ensure that the machine you are installing it on meets the minimum hardware
and software prerequisites.

Install the Support Tools Server
The Support Tools Server installation includes:

» The Support Tools Dashboard

The Support Tools Node

Support Tools documentation

Java Virtual Machine (JVM) 1.5.0_15
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About Installing Support Tools

» Apache Tomcat 5.5.26

Review the Support Tools Node hardware and software prerequisites

Prior to installing the Support Tools Node, ensure that the supported Cisco Unified software products you are installing
it on meet the minimum hardware and software prerequisites.

Install the Support Tools Node

Install the Support Tools Node on each ICM or related Cisco Product you want to manage through Support Tools. The
Support Tools Nodes installation includes:

» The Support Tools Node Agent Service
 Support Tools Web utilities and certain Unix-style 3rd Party Common Tools.
» Support Tools documentation

Note: Other Support Tools utilities are not part of the Support Tools installation. Rather, these utilities already exist
on each node, distributed as part of standard ICM and Windows installations.

Enable ports for Support Tools
Support Tools uses the following ports:

» Tomcat (the Cisco CCBU Support ToolsHTTP Server) by default listens for HTTP requests on port 8188. It
listens for HTTPS requests (used for SSL) by default on port 8189.

» Support Tools requires a port (39100 by default) to communicate between the Support Tools Server and Nodes.
Ensure that this port is available on each node managed by Support Tools.

If a firewall stands between the Support Tools Server and any Support Tools node, and/or between the Support Tools
Server and remote users, you must open these ports on the firewall.

Test the installation

After installing Support Tools, perform a few simple tests to verify that the install was successful.

Post-Installation Configuration

All basic configuration required by Support Tools is set during installation. Immediately after
installation, no further configuration is necessary to begin using the product.

However, as desired, after installation you can modify the settings chosen during installation,
or use certain optional behaviors that require further configuration.
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About Installing Support Tools

How to Collect Information for Support Tools Installation

Step 1

Step 2

Prior to installing Support Tools, collect the following information that you will need to provide
during the install

For the Support Tools Server

a.  Determine the name of the Support Tools privileged user group. Determine which users
will be members of this group.

b.  Determine the username, domain, and password of the distinguished user (page 40) for
the Cisco CCBU Support Tools HTTP Server.

c.  Determine the IP address or fully-qualified DNS of your network time server.

To use Support Tools merged log capabilities, each Support Tools Server and node must be
able to communicate with the same Simple Network Time Protocol (SNTP or NTP) server. This
is required even for networks that have fully synchronized Windows 2000/2003 systems as the
allowable machine drift is greater than the tolerance of the log event times.

Note that Support Tools does not make time adjustment to host machines. Instead, the time
offsets are tracked in a database to use for log merging only. Your SNTP or NTP server must
support unauthenticated requests. Refer to RFC-2030 for more details on SNTP. Most Cisco
IP Routers support the SNTP / NTP protocol. Consult with your IT department on available
SNTP / NTP servers in your network.

If any system in a merged log collection cannot communicate with the SNTP server, the merge
will fail, and the outputted log will contain the alert: "Missing SNTP data for all of the following
files logs prevented merging logs:..."

For the Support Tools Node

a.  Take an inventory of the supported Cisco Unified software productson which you want
to install Support Tools.

b.  Determine the IP address or fully-qualified DNS of your network time server (SNTP).
However, you can leave this blank if the SNTP address was filled in on the Support Tools
Server. The Support Tools Server pushes the value out to the node. Note that this only
occurs if the SNTP server field is blank. If a value is pushed to the node and the address
later changes, you must manually change the address on the Support Tools Node to point
to the new SNTP server.

c.  Determine whether a firewall stands between the Support Tools Server and any supported
Cisco Unified software products it will manage. If so, open the required ports.
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How to Create Support Tools User Groups

How to Create Support Tools User Groups

Support Tools recognizes two categories of users:

 Privileged users have full access to all Support Tools functionality, including tools and
commands that can be used to modify system settings, registries, etc.

» Regular users have limited access to information gathering functionality only. Tools capable
of system modification are not available to regular Support Tools users.

This topic includes the following subtopics

» To Create Support Tools User Groups (page 39)

» Creating Local Accounts on the Support Tools Server (page 39)

To Create Support Tools User Groups

Support Tools assigns privilege based on regular Windows user groups. This can be either a
local group you define on the Support Tools Server machine or adomain group you define using
Active Directory.

During the Support Tools Server installation, you are prompted to enter the name of one (and
only one) Windows user group that will serve as the Support Tools privileged group. Users in
all other groups are treated as regular Support Tools users.

Note:

» The privileged user group name is case-sensitive. It must match in case its corresponding
Windows user group name.

 All Support Tools users must be members of the Windows Everyone group; anonymous users
will not have access to Support Tools.

After installation, if necessary, you can modify the privileged group name by running the
Support Tools Server configuration.

Creating Local Accounts on the Support Tools Server

To ensure you have local access to the Support Tools Dashboard in situations when network
authentication is unavailable (for example, due to a downed network or authentication server)
it is a good idea to create one or more local user accounts on the Support Tools Server.

To ensure full access to all utilities, these local accounts should be made members of a local
user group named identically to your Support Tools privileged user group.
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How to Prepare the Distinguished User Account

When logging into the Dashboard using a local account, enter <hostname>\<Windows_username>
as your username; for example, my_server\my_username.

How to Prepare the Distinguished User Account

The Support Tools Server installs the Cisco CCBU Support Tools HTTP Server (Tomcat) which
runs as a service. This service must run as a distinguished user. To do this:

1. Prior to installing the Support Tools Server, create the Distinguished User account as
described in How to Create the Distinguished User Account (page 40).

2. After installing the Support Tools Server, assign the Distinguished User the requisite
directory privileges as described in How to Assign Directory Privileges to the Distinguished
User (page 40).

How to Create the Distinguished User Account

Beforeinstallingthe Support Tools Server, on the machine on which the Support Tools Server
will be installed, create a local or domain account to be used for the Cisco CCBU Support Tools
HTTP Server (Tomcat) service.

Note: This account is only used to run the Cisco CCBU Support Tools HTTP Server (Tomcat)
Service and should not be an administrator or user account for any other purpose. Create a local
account since this will restrict access of the Cisco CCBU Support Tools HTTP Server (Tomcat)
Service to the one machine. In some scenarios using a local account for the service will prevent
users from authenticating with a domain account. If this condition exists, you will need to use
a domain account instead.

How to Assign Directory Privileges to the Distinguished User

If your Support Tools Server uses NTFS directory security that limits directory access to specific
users, after installing the Support Tools Server, ensure that, in addition to the <machine>\System
account, the distinguished user for the Cisco CCBU Support Tools HTTP Server (Tomcat)
Service has the following privileges to the Support Tools root directory and all of its
subdirectories:

« Modify
» Read & Execute

List Folder Contents

e Read

o Write
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How to Install the Support Tools Server
For example, If the Distinguished User specified during installation is
my_domain\tomcat_svc_acct, then my_domain\tomcat_svc_acct must be given the rights
listed above to the Support Tools root directory and all of its subdirectories.
See your Windows documentation for instructions on granting NTFS security privileges.
See also:
» How to Install the Support Tools Server (page 41)

» How to Install the Support Tools Node (page 43)

» How to Test the Support Tools Installation (page 45)

How to Install the Support Tools Server

You can install the Support Tools Server on any server with access to your ICM system. Before
installing the Support Tools Server, ensure that the machine meets the prerequisite hardware
and softwar e requirements.

Warning: In someinstances, the Support Tools Server and Node installation may require
areboot to complete. For thisreason, you should perform theinstallation during aregular
maintenance period when the machineisin off-production mode.

The Support Tools 2.4(1) CD includes a Server Install Wizard that installs:

» The Support Tools Dashboard

» The Support Tools Node

» Support Tools documentation

« Java Virtual Machine (JVM) 1.5.0_15

» Apache Tomcat 5.5.26

Note: The following installation instructions describe only those installer dialogs that require

user input.

1. Log into the machine on which you are installing the Support Tools Server under an
account with local Windows Administrator privileges for that machine.

2. If the Cisco Security Agent is running on the machine, stop its service and set the service
startup type to Disabled.

3. Insert the Support Tools CD in the server's CD-ROM drive. Normally an autorun executes
and you can skip the next two steps.

4, If the autorun does not execute, from the Windows Start Menu, select Run.
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How to Install the Support Tools Server

5. Browse to and double-click the Support Tools Server executable file located at:
Server\setup.exe.

6. If the installer detects a previous, earlier installation of the JVM (less than 1.5.0_15), you
will be prompted to confirm an overwrite. Click Yes.

7. Specify values for each of the following:

—  Destination Path: Specify the location to install the Support Tools Server, or accept
the default: c:\Cisco\CCBU\SupportTools. You can install the Support Tools Server
to any location on the local machine.

Note: If you plan on using the Cisco Security Agent (CSA) you can only change the
drive letter and must leave the remaining default path information. This is because
CSA security rules are written specifically based on the path names.

—  Administration Group Name: The name of the Windows User Group that has access
to Support Tools functions capable of system modification (non-administration group
users can use Support Tools for information gathering only). The default is
Administrators.

Note: The Administration Group name is case-sensitive. It must match in case its
corresponding Windows user group name.

—  Domain, Username, and Password of user that the Cisco CCBU Support Tools HTTP
Server (Tomcat) should run under. For more information, see How to Create the
Distinguished User Account.

Note: Use the Test button to test Authentication.

—  TCP/IP Port: The port the Support Tools Server uses to communicate with Support
Tools Nodes. The default is 39100.

—  HTTP and HTTPS Ports: Specify the ports that the Cisco CCBU Support Tools
HTTP Server (Tomcat) should use for HTTP and HTTPS requests. The Support
Tools defaults are 8188 (HTTP) and 8189 (HTTPS).

—  Network Time Server: Specify the static IP address or fully-qualified DNS of your
network time server. Also specify the frequency (in minutes) with which this machine
should reconcile its clock against the network time server. Will network time server
usage is optional, without it merged logs cannot be collected.

Note: As necessary, these values can also be modified after installation.

—  Repository Base Directory: Specify the path to the Support Tools Server Repository.
This is the location where log files and saved registries and processes lists are stored.
You can specify any location on the Support Tools Server's physical drive. The
default is <destination_path>\Repository.

—  IPSec Preshared Key: For Windows 2003 installs only, you have the option of entering
an IPSec key that authenticates the Support Tools Server to individual nodes. Keys
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Support Tools Server and Cisco Unified Customer Voice Portal Operations Console Co-Residency

are case-sensitive and limited to 256 characters. You can use any character except
single and double quotation marks, back slash, and pipe.

Note: If an IPSec policy is already assigned on you machine, you will not be prompted
to enter a preshared key. For more, see Automated IPSec Implementation (page 32).

8. When the installation is complete, click Finish.
Depending on your local machine's configuration, you may be prompted by the installer
to reboot the machine to complete the installation. The Support Tools Server and Cisco
CCBU Support Tools HTTP Server (Tomcat) services will start automatically upon reboot.

9. If you are not prompted to reboot, the Support Tools Server and Cisco CCBU Support
Tools HTTP Server (Tomcat) services will start automatically and is ready for use.

10. If you stopped the Cisco Security Agent for the installation, start its service and set the
service startup type to Automatic.

SupportTools Serverand Cisco Unified Customer Voice Portal Operations Console Co-Residency

Beginning with Support Tools 2.4(1), you can install Support Tools Server on the same server
where the Unified CVP Operations Console (4.x or 7.x) has previously been installed.

Notes:

» You must restart Unified CVP after installing the Support Tools Server over an existing
Operations Console.

» The Operations Console must be installed first, followed by the Support Tools Server, in
order to enable co-residency.

» Co-residency of the Support Tools Server and the Operations Console is not supported if any
other ICM component is installed on the Unified CVP Server.

How to Install the Support Tools Node

You can install the Support Tools Node on any supported Cisco Unified software component
that you want to manage through Support Tools.

Note: Before installing the Support Tools Node, ensure that the machine meets the prerequisite
har dware and softwar e requirements.

Warning: In someinstances, the Support Tools Server and Node installation may require
areboot to complete. For thisreason, you should perform theinstallation during aregular
maintenance period when the machineisin off-production mode.

The Support Tools CD includes a Server Install Wizard that installs:
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» The Support Tools Dashboard

» The Support Tools Node

» Support Tools documentation

Note: The installation instructions below describe only those installer dialogs that require user
input.

1.

Log into the machine on which you are installing the Support Tools Server under an
account with Windows Administrator privileges.

If the Cisco Security Agent is running on the machine, stop its service and set the service
startup type to Disabled.

Insert the Support Tools CD in the server's CD-ROM drive. Normally an autorun executes
and you can skip the next two steps.

If the autorun does not execute, from the Windows Start Menu, select Run.

Browse to and double-click the Support Tools Node executable file located at:
nodes\setup.exe.

Specify values for the following:

—  TCP/IP Port: The port the Support Tools Server uses to communicate with Support
Tools Nodes. The default is 39100.

—  Destination Path: Specify the location to install the Support Tools Node, or accept
the default: c:\Cisco\CCBU\SupportTools. You can install the Support Tools Node
to any location on the local machine.

Note: If you plan on using the Cisco Security Agent (CSA) you can only change
the drive letter and must leave the remaining default path information. This is because
CSA security rules are written specifically based on the path names.

—  Network Time Server: Specify the static IP address or fully-qualified DNS of your
network time server. Also specify the frequency (in minutes) with which this machine
should reconcile its clock against the network time server.

Note: As necessary, this value can also be modified after installation.

—  IPSec Preshared Key: For Windows 2003 installs only, you have the option of entering
an IPSec key that authenticates the Support Tools Server to individual nodes. Keys
are case-sensitive and limited to 256 characters. You can use any character except
single and double quotation marks, back slash, and pipe.

Note: If an IPSec policy is already assigned on you machine, you will not be prompted
to enter a preshared key. For more, see Automated IPSec Implementation (page 32).

When the installation is complete, click Finish.
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How to Test the Support Tools Installation

8. Depending on your local machine's configuration, you may be prompted by the installer
to reboot the machine to complete the installation. The Support Tools Node will start
automatically upon reboot.

9. If you stopped the Cisco Security Agent for the installation, start its service and set the
service startup type to Automatic.

How to Test the Support Tools Installation

After installing Support Tools, you should test your installation by:
» Accessing the Support Tools Dashboard.

 Testing the connection to Support Tools Nodes.

1. Access the Support Tools Dashboard.

2. Open a Web browser and in the Address line, enter: http://
<hostname_or_ip_address>:<Tomcat HTTP_port>.

Note: The Cisco CCBU Support Tools HTTP Server (Tomcat) default http port is 8188.
This default can be modified during installation.

3. Press <Enter>. The Support Tools Dashboard Login screen opens.

a.  Inthe Login Name field, enter <Windows_domain>\<Windows_username>. For
example, my_domain\my_username.

b.  Inthe Password field, enter your Windows password (case-sensitive)
c. Click Login.
4. Test the Connection to a Support Tools Node

—  On the System Management screen, add the node(s) you want to test to the system
list.

—  Test the Connection to a Support Tools Node

—  On the System Management screen, use the Test Connection utility to confirm the
connection to individual nodes.
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@ Chapter 7

Configuring Support Tools

This chapter contains the following topics:

About Configuring Support Tools, page 47

How to Modify Support Tools Basic Configuration, page 48

How to Disable Continuous Virus Scan for the Repository, page 49

How to Modify Processes and Services Listed in the Process Information List, page 50
How to Configure SQL for Use with the System Interrogate Tool, page 51
Configuration of sysquery and Trace, page 52

About Configuring Support Tools

All basic configuration required by Support Tools is set during installation. Immediately after
installation, no further configuration is necessary to begin using the product.

However, at some point you may want to modify the settings chosen during installation, or use
certain optional behaviors that require further configuration.

These post-installation configuration options include:

M aodifying the basic Support Tools setting specified during installation (network time
server, privileged use group, Repository path, and TCP/IP port).

Excluding the Support Tools Repository from continuous vir us scans.
Installing Windows M anagement I nstrumentation (WM1) on Cisco Unified Nodes
running SQL 2000 so that this information can be reported on by the Support Tools System

Interrogate utility.

Adding information about specific processes and servicesthat display in the Processes
& Services screen.
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How to Modify Support Tools Basic Configuration

How to Modify Support Tools Basic Configuration

Communication Port

The basic configuration settings necessary to run Support Tools (network time server, privileged
use group, Repository path, and TCP/IP port) are specified during installation. While not typically
necessary, you can modify these settings after installation.

Support Tools keeps most of its configuration values in the Windows Registry. The base key
for all values is: HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, IncA\CCBU\Support
Tools.

Note: After modifying any of the following settings you must restart Support Tools services
for the change to take effect.

The ports the ST processes use are defined in the Windows registry at the following DWORD
value: HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.A\CCBU\Support
Tools\AppServer\Port

Location of the Support Tools Installation

This value is stored in the Windows registry in: HKEY _LOCAL_MACHINE\SOFTWARE\Cisco
Systems, Inc.A\CCBU\Support Tools\AppServer\InstallPath. This can be changed in the registry,
but you must manually move the directory on the file system to the new location.

Location of the Support Tools Repository

This value is stored in the Windows registry in: HKEY_LOCAL_MACHINE\SOFTWARE\Cisco
Systems, Inc.\CCBU\Support Tools\AppServer\RepositoryBaseDir. This can be changed in the
registry, but you must manually move the directory on the file system to the new location. The
repository location must be on a local disk (i.e., it cannot be on a network share).

Support Tools Administrative Group

This value is stored in the Windows registry in: HKEY _LOCAL_MACHINE\SOFTWARE\Cisco
Systems, Inc.A\CCBU\Support Tools\Privileged Group\GroupName.

Tomcat Designated User

Account information for the Tomcat Designated User (user name, domain) is stored in the
Windows registry in: HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems,
Inc.\CCBU\Support Tools\AppServer\DistinguesdDomainName and
HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.A\CCBU\Support
Tools\AppServer\DistinguesdUserName.

Cisco Support Tools User Guide for Cisco Unified Software Release 2.4(1)

48



Chapter 7: Configuring Support Tools

TCP/IP Port

How to Disable Continuous Virus Scan for the Repository

Note: The password for the Designated User is not stored in the registry. It must be modified
(if desired) via the Windows User Panel.

(should never be changed) This value is stored in the Windows registry in:
HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\CCBU\Support
Tools\AppServer\Port This value can be changed, but it must be changed to the same value on
all Support Tools Servers and Nodes.

How to Disable Continuous Virus Scan for the Repository

Support Tools writes a large number of files (.log, .txt, .xml, and .zip) to the Repository in the
course of normal use. The quantity of these files, if used in conjunction with continuous virus
scanning, could result in a negative impact on performance.

If this performance degradation is not acceptable then you can restrict continuous virus scanning
in the Repository directory and its subdirectories to known file types only (which should omit
Jog and .txt files from scanning).

If performance degradation persists, then :

» Exclude the Repository directory and its subdirectories from continuous virus scans run on
the Support Tools Server and Node machines. Instead, limit scans on these directories to a
nightly basis.

» After disabling virus scanning for the Repository directory and its subdirectories, use NTFS
directory security to limit full access to these directories to administrators, NT

Authority\System, NT Authority\Service and any other distinguished users that require direct
access to these directories.

Warning: StepsA and B above should be used in concert with each other; that is, do not
disable continuous vir us scanning without also implementing NTFS directory security on
the affected directories.

The default location of the Support Tools Repository on both the server and node is
<support_tools_root>\Repository.

See also:
» How to Modify Processes and Services Listed in the Process Information List (page 50)
» How to Configure SQL for Use with the System Interrogate Tool (page 51)

» Configuration of sysquery and Trace (page 52)
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How to Modify Processes and Services Listed in the Process Information List

Step 1

Step 2

The process information list stores information about specific processes and services. The
information from this file is then displayed to Support Tools users when they use the Processes
and Services utility.

For each process or service defined therein, the file includes:

» The name of the process or service

» Whether the process is known, unknown, or critical

» Explanatory text about the process

Out-of-the-box, the process information list includes information on the following processes:
» All Cisco processes are identified as Known.

» Certain critical Microsoft OS-related processes are identified as Critical.

» Certain SQL and common Microsoft processes are identified as Known.

As desired, you can modify the process information list to add new information about processes
or services. For example, if you are running a virus checker, you may want to tag it as critical.

Note:

 Services are listed only if they have a known name. The known name is derived from the
.exe file name of the service. For example, the process named "tomcat.exe" is also the service
"Cisco Support Tools HTTP Service". Prior to making additions or modifications of a service
be sure to correlate the .exe file name of the service with the service name.

» Do not modify systemlist.xml file. Changes to this file are not supported by Cisco.

Use a text editor to open processinfo.xml located on the Support Tools Server at
<support_tools_root>\repository\system files\

Note: Only the processinfo.xml file on the server needs to be modified. The server pushes the
modified file out to all Support Tools nodes connected to the server.

If you have multiple Support Tool Servers then you should make the same modifications to all
servers if the servers connect to the same nodes. Otherwise the processinfo.xml on the
nodes may be different, depending on which server they are currently connected.

Using proper well-formed XML syntax, add or modify entries as follows:
» Process Type: Known, Unknown or Critical. Note: Use only these designations. Others will

not parse correctly. Designating a process as Critical will prevent Dashboard users from
stopping it (on the Services screen).
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« Name: The name of the process or service. Can include, but does not require, an .exe extension.
« Manufacturer: Optionally, the manufacturer of the process or service.
« Help: Any explanatory information you wish to display about the process or service.

« Example: <process type="known" name="notepad.exe"
manufacturer="Microsoft'><help>This is Microsoft"s Notepad text
editor</help>

When editing the file, consider the following:

 Cisco processes and services not identified in processinfo.xml are nonetheless automatically
detected by the Processes and Services utility and labeled as Known.

« Non-Cisco processes and services not identified in processinfo.xml are labeled as Unknown.

» Be aware that Support Tools Dashboard users will be unable to stop services and processes
tagged Critical.

« Consider that there is value in leaving less important processes and services tagged as
Unknown. It allows Support Tools users to bulk select these items for termination when
troubleshooting a node.

« Be careful to use correct XML syntax when editing the file. Incorrect syntax makes the file
unreadable to the Support Tools parser, causing all but Cisco processes and services to display
as Unknown.

The current processinfo.xml file is automatically propagated from the Support Tools Server to
individual Support Tools nodes when these systems are selected for use from the Dashboard.
In this way, an updated version of the file is available to users who launch the Processes and
Services utility directly from a node via command line.

Note however that there may be instances where you may want or need to manually copy an
updated processinfo.xml file from the Support Tools Server to another machine: for example,
if you are running multiple installations of the Support Tools Server, or if you have nodes that
are rarely selected for use from the Dashboard, but on which users may run the Processes and
Services utility from a command line.

How to Configure SQL for Use with the System Interrogate Tool

In order for the Support Tools System Interrogate utility to access and report on an ICM system's
SQL database information, it must have access to Microsoft's Windows Management
Instrumentation (WMI). WMI is not part of a standard Windows SQL install, and in most cases
will therefore need to be installed separately. To Install WMI:
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Configuration of sysquery and Trace

Step 1

Step 2

Obtain the SQL 2000 Server CD, or download WMI at: http://msdn.microsoft.com/downloads/
list/wmi.asp

On each ICM system that has SQL installed (and with which you want to use the System
Interrogate utility--(for example, loggers, AWSs) run setup from the \x86\OTHER\wmi directory.

Note: For additional information on installing and using WMI, see the MSDN library at: http:/
/msdn.microsoft.com/libr ary/default.asp?url=/libr ar y/en-usiwmisdk/wmi/sgl_for_wmi.asp

Configuration of sysquery and Trace

The sysquery and trace configuration files also exist on the Support Tools Server. However
these files should not be modified. Modifications to these files are not supported. If modifications
are deemed necessary by Cisco Systems Inc., then updates will be made available using the
patch process.
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# Chapter 8

Uninstalling, Reinstalling and Upgrading Support
Tools

This chapter contains the following topics:

» How to Uninstall Support Tools, page 53
» How to Reinstall Support Tools, page 54
» Upgrading Support Tools, page 54

How to Uninstall Support Tools

Step 1

Step 2

As desired, you can uninstall the Support Tools Server or Node by following the steps below.
Note that it is not necessary to uninstall either as a precursor to reinstalling the product. This
topic describes how to uninstall the Support Tools Server and the Support Tools Node.

To Uninstall the Support Tools Server

Uninstalling the Support Tools Server removes the Support Tools Server, its associated utilities,
and registry entries associated with Support Tools. Note that uninstalling the Support Tools
Server does not automatically remove the Repository files.

a.  From the Windows Start menu, select Settings > Control Panel > Add/Remove Programs
> Cisco Support Tools.

b.  Click Remove.
c.  The uninstaller will ask if you want to remove everything. Select Yes.

d.  If desired, after running the uninstaller, use Windows Explorer or a similar file management
tool to delete the Support_Tools directory.

To Uninstall the Support Tools Node
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How to Reinstall Support Tools

Uninstalling the Support Tools Node removes the Node only--it does not remove utilities or
other items that are part of a standard ICM installation.

a.  From the Windows Start menu, select Settings > Control Panel > Add/Remove Programs
> Cisco Support Tools.

b.  The uninstaller will ask if you want to remove everything. Select Yes.

c.  Ifdesired, after running the uninstaller, use Windows Explorer or a similar file management
tool to delete the Support_Tools directory.

After removing Support Tools from an ICM or related Cisco Product Node, you should also
remove that node's entry in the Support Tools System List (in the Support Tools Dashboard).

How to Reinstall Support Tools

As desired, you can re-install the Support Tools 2.4 Server or Node, using the same steps
employed for an initial installation.

Warning: Prior to re-installing Support Tools 2.4, you must uninstall it following the
uninstallation instructionsin this guide. Failing to uninstall Support Tools prior to a
reinstall can cause problemswith | PSec functionality (see Troubleshooting).

Upgrading Support Tools

You upgrade support tools simply by running the appropriate Support Tools 2.4(1) installer
(Server or Node) on a machine with an existing Support Tools Server or Node. The Support
Tools Repository remains intact and saves the files from your previous version of support tools.

You can optionally upgrade from a Node to a Server. The installation program asks you if you
are sure that you want to follow one of these upgrade methods so that you do not mistakenly
upgrade a Node to a Server or a Server to a Node.
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Using the Support Tools Dashboard

This chapter contains the following topics:

About the Support Tools Dashboard, page 55
Accessing the Dashboard, page 56

Dashboard Privileges, page 56

Using the Dashboard for the First Time, page 57
How to Access the Support Tools Dashboard, page 58
How to Use the System Management Tool, page 59
How to Use the Select System Tool, page 61

How to End a Dashboard Session, page 62

About the Support Tools Dashboard

The Support Tools Dashboard is a browser-based interface that allows you to access and use
all Support Tools utilities through a single interface. The Dashboard integrates access to all
Cisco Unified software components where the Support Tools Node has been installed, eliminating
the need to manually connect to each remote system.
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Figure 2: Support Tools Dashboard
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Accessing the Dashboard

Users access the Dashboard via a URL (http://
<hostname_or_ip_address>:<support_tools_port>/you must login by providing

your Windows user name and password, or the user name and password of a privileged account.

Dashboard Privileges

The Support Tools Dashboard recognizes two categories of users:

« Privileged users have full access to all Support Tools functionality, including tools and

commands that can be used to modify system settings, registries, etc.

» Regular users have limited access to information gathering functionality only. Tools capable

of system modification are not available to regular Support Tools users.

This can be either a local group you define on the Support Tools Server machine or a domain
group you define using Active Directory. During the Support Tools Server installation, you are
prompted to enter the name of one (and only one) Windows user group that will serve as the
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Support Tools privileged group. Users in all other groups are treated as regular Support Tools
users.

Using the Dashboard for the First Time

This topic describes some basic, important information on using the Support Tools Dashboard
that all new users should be aware of.

Accessing Utilities in the Dashboard

All Support Tools utilities are accessed from the Support Tools menu. The menu groups utilities
(with the exception of System Management which appears right under the main Support Tools
heading) as:

» |nteractive Mode

Select System

System Interrogate

Registry

Registry Compare

Processes

Services

Trace and Log

Common Tools (Including; Cisco and Third Party tools)

e Batch Mode

System Interrogate

Registry

Processes

Services

Trace and Log

Common Tools (Including; Cisco and Third Party tools)

Note that if you are not a member of the privileged user group, certain utilities will not be
available to you and will not appear on the Support Tools menu. See About the Support Tools
Utilities for a list of these privileged tools.
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Selecting a System to Work With in Interactive Mode

The first action you typically take after logging in to the Dashboard is to select the system that
you want to work with. Many Support Tools I nteractive M ode utilities cannot be used until
you first select a system.

Select the current system using the Select System utility. After you have completed working

with that node, you can use the Select System utility to choose a different system to work with.

Adding a System to the System List

In order to select a system to work with, you may first need to add it to the Support Tools system
list (if it is not already defined in the list). You can do this using the Select System or System
Management screens.

You add multiple systems by clicking Support Tools > System Management
In order to add a system to the list:
1. The Support Tools node must have been installed on the node, and
2. You must know the node's DNS entry or IP address.
Automated Node Addition: For Unified CVP 4.x nodes and other Support Tools Servers the

System Management page allows automated addition of Unified CVP 4.x nodes and other
Support Tools Servers.

Navigating and Refreshing Pages in the Dashboard

When using the Dashboard, it's important to navigate and refresh pages using only the controls
in the Dashboard interface.

Avoid navigating and refreshing using controls belonging to your browser, specifically the
browser Forward, Back, and Refresh commands. Dashboard pages expire as soon as a request
for a subsequent page is made; therefore, using the browser's Forward and Back commands
may return you to an expired page. Because the Dashboard uses a frameset, its pages may not
refresh properly using the browser Refresh command.

How to Access the Support Tools Dashboard

To access the Support Tools Dashboard:

Step 1 Open a supported Web browser and in the Address line, enter (for example): http://
<hostname>:8188/.
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How to Use the System Management Tool

Note: You can also specify the machine's IP address in place of its DNS entry. Note that the
URL above uses Support Tools's default HTTP port.

Step 2 Press <Enter>. The Support Tools Dashboard Login screen opens.

Note: The default mode for Support Tools is to use SSL. You may see a warning such as the
one pictured below. Click OK to accept the security certificate.

Figure 3: Login Security Warning
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Step 3 In the Login Name field, enter <Windows_domain>\<Windows_username>. For example,
my_domain\my_username.

Step 4 In the Password field, enter your Windows password (case-sensitive)

Step 5 Click Login.

How to Use the System Management Tool

Use the System Management Tool to:
» Add Support Tools nodes to the Support Tools system list
» Remove nodes from the system list

 Test the connection between the Support Tools Server and a node

To open the System Management Tool, from the Dashboard menu, select System Management.

To Add a Node to the System List

Adding a node to the system list makes it available for quick selection during future Dashboard
sessions.
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Step 1

Step 2

In the Add Systems box, add the DNS entry or IP address of one or more Support Tools nodes.

Add each node on a separate line. Do not use a delimiter (for example, a comma) to separate
entries.

Note: System host name can not be greater than 30 characters. Use the system's IP address if
the host name is longer than 30 characters.

Note that entries are not validated for correctness.

Click the Add System Button.

To Automatically Add Unified CVP and Support Tools Server Nodes

Step 1

Step 2
Step 3

Step 4

Once you have added a Unified CVP 4.x node or a Support Tools Server 2.4 node, you can
automatically add all nodes defined on their system lists to the current Support Tools Server's
system list.

Add at least one Unified CVP node and/or Support Tools Server node, following the process
described in To Add a Node to the System List.

In the System Management box, select the node you added.
Check the Add Systems List from Tested Systems check box.

Click the Test Connection button. Any new nodes are automatically added to the system list.

To Test the Connection to a Node

Step 1

Step 2

Testing the connection tests the connection between the Support Tools Server and one or more
nodes.

In the System Management box, highlight the Support Tools node(s) that you want to test.
Click the Test Connection button.

If the system you attempt to test is not available, an error message displays. Check that: the
node's DNS or IP address was entered correctly in the system list; the network connection to
the node is active; the Support Tools Node Agent Service is installed and running on the node.

To Delete a Node from the System List

To delete a Support Tools node from the system list:
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Step 1

Step 2

How to Use the Select System Tool

In the System Management box, highlight the Support Tools node(s) that you want to delete
from the list.

Click the Remove Systems(s) button.

How to Use the Select System Tool

Selecting a system specifies the Support Tools node that you want to work with. You must
select an ICM or related Cisco product node before you can interact with it through the Interactive
Mode of the Support Tools Dashboard.

Note: Selecting a system is only required when you want to use | nteractive M ode utilities.
You do not need to select a system using the Select System tool when using Batch M ode
utilities.

To open the Select System tool, from the Dashboard menu, select I nter active Mode > Select
System.

For further information, see How to Select a System (page 61)

How to Select a System

Step 1

Step 2

Step 3

To select a system from the existing System list:

From the Dashboard menu, select I nteractive Mode > Select System.

Click the Select System radio button, and then highlight the system you want, OR...

To select a system not on the System list, click the Enter System Name radio button, and then
enter the DNS entry or IP address for that node. Optionally, to also add this node to the System
list, check Add To List Of Systems.

Click Select System. The node is thereafter displayed as the current system at the top of each
Dashboard tool. Also indicated are the ICM product type(s) installed on the system.

These can include:

* ICM (AWs, PGs, Call Routers, and Loggers)
« Call Manager (CCM)

» CTIOS Server

» |PCC Express (CRS)

» Cisco Agent Desktop (CAD)

» Cisco Security Agent (CSA)
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Cisco Unified Customer Voice Portal (Unified CVP)

« E-Mail Manager (CEM)

Media Blender (CMB)

Collaboration Server (CCS)

Note:

 This list may not be complete or accurate depending on your deployment. Node types are
defined in a static configuration file and may differ from the ones listed here.

* |f the system you attempt to select is not available, an error message displays. Check that:
the node's DNS or IP address was entered correctly; the network connection to the node is
active; the Support Tools Node Agent Service is installed and running on the node. If you
are using the node's host name, try connecting to the host using its IP Address or fully qualified
domain name instead.

Adding a Support Tools Node to the System List

Step 1

Step 2

Step 3

Step 4

Adding a node to the system list makes it available for quick selection during future Dashboard
sessions. Adding a node to the system list also specifies it as the current system.

Click Support Tools > Interactive M ode > Select System

Click the Enter System Name radio button, and then enter the DNS entry or IP address for that
node.

Check Add To List Of Systems.
Click Select System. The node is displayed as the current system at the top of the screen.

Note:

« |f the system you attempt to select is not available, an error message displays. Check that:
the node's DNS was entered correctly; the network connection to the node is active; the
Support Tools Node Agent Service is installed and running on the node.

» To add multiple nodes more quickly, use the System Management tool.

How to End a Dashboard Session

To terminate a Dashboard session, click the Logout link in the Dashboard. Dashboard sessions
also time out automatically after 60 minutes after you close your browser.
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Note:

 Sessions will time out when your browser remains open and no activity takes place for
extended periods of time.

» Terminating a session will not terminate any Dashboard processes that may be running (for
example, log collection). These will continue to run to completion.

» The Dashboard does not place a restriction on multiple logons. It is not necessary to terminate
a session in order to begin a new one.
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How to End a Dashboard Session
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Using Support Web Tool Utilities from the Dashboard

This chapter contains the following topics:

« About Support Utility Web Tools, page 65

« About Event Collection, Event Detection, and Alerts, page 67

« How to Use the Event Detection and Alert Menu, page 67

» How to Use the System Interrogate Screen, page 70

« How to Use the History Tools, page 80

» How to Use the Registry Tool, page 82

« How to Use the Registry Compare Tool, page 83

» How to Use the Processes Tool, page 88

» How to Use the Services Tool, page 89

« About Trace and Log, page 91

» How to Use the Create Log Group Screen, page 92

» How to Use the Log Groups Screen, page 94

» How to Use the Create Trace Group Screen (Batch Mode), page 96

» How to Use the Create Trace Group Screen (Interactive Mode), page 97
« How to Use the Trace Groups Tool, page 98

» How to Use the Schedule Trace Screen, page 100

« About Log Collection, page 101

» How to Use the Collect Logs Screen (Batch Mode), page 104

« How to Use the Log Collections Screen, page 105

« How to Use the Collect Logs Tool (Interactive Mode) , page 108

« Improved log collection on Cisco Unified Communications Manager servers, page 109
 Collection of Capture files, page 109

» How to Use the Performance Monitor Tool (Interactive Mode), page 110
» How to Load .CSV files into the Windows Perfmon Application, page 112

About Support Utility Web Tools

Support Web Tools are a set of Cisco-authored utilities specifically designed for use with the
Support Tools. They are installed on all Support Tools nodes.
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About Support Utility Web Tools

Many Web Tools can be run either from the Support Tools Dashboard or via command line on
an individual node. Command-line access to individual nodes can be local or remote (via methods
like TelNet, pcAnywhere, etc.). However, they were primarily designed for Web access through

the Dashboard.

All Web Tools allow you to save (to the Repository) and download file images of the data they

collect.

Note: Within the Dashboard, the functionality of some Web Tools is distributed among several
different tools (pages). For example, Processes and Services utility functionality is divided

among a Processes tool and a Services tool.

Table 2: Web Tools at a Glance

Alert

alerted. Allows you to configure email destination for
the alert notification. Also allows you to enable or
disable the alert tool, to enable or disable email alert
capability, and to clear the alert.

Tools nodes

Tool Name: Description: Installed On: Dashboard
Privileged
Users
Only:
Trace and Log Use to collect and view log files from ICM or related | All Support Tools nodes
Cisco Unified Product Nodes. Allows you to create
merged logs from two ICM or related Cisco Product
Nodes for comparative analysis, Also allows you to
create trace groups for log groups, and turn on/off the
different trace groups on a schedules basis.
Registry Use to view ICM or related Cisco Product Node All Windows-based Support | X
registry entries. Tools nodes
Registry Compare |Use to compare and synchronize Support Tools node | All Windows-based Support | X
registry entries Tools nodes
System Interrogate |Use to display system information (for example, OS, | All Windows-based Support
hardware, ICM, SQL). Tools nodes
Processes Use to view and stop Processes running on a Support|All Windows-based Support | X
Tools node. Tools nodes
Services Use to view and stop Services running on a Support |All Windows-based Support | X
Tools node. Tools nodes
Performance Use to collect and monitor performance object and |All Windows-based Support | X
Monitor counter log files. Tools nodes
Event Detection and | Use to select the events to which you want to be All Windows-based Support | X
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About Event Collection, Event Detection, and Alerts

The Support Tools Application Server collects and logs “syslog” messages and alerts an
administrator through email when a critical event is detected. This feature is not installed on
the Node Agent.

The Event Detection and Alerting tool runs automatically as part of the Application Server and
is enabled by default. It can be enabled or disabled by the administrator from the Event Detection
and Alert menu. "Syslog" messages sent to the configurable port from any source are logged
without modification in the order received to a file in the repository.

When a selected event is identified, an alert is sent to one or more configured recipients using
the Simple Mail Transfer Protocol (SMTP). Once an alert is sent, no further alerts will be sent
for detected events until the alert condition is cleared.

There are 3 options for clearing the alert condition:

« Manually. After an alert is sent, no more alerts will be sent until the Clear Alert button is hit.
» Automatically after a configurable timeout. Manually clearing the alert will override the wait.

» Never. An alert is always sent for a detected event.

How to Use the Event Detection and Alert Menu

Use the Event Detection and Alert menu to:

» Configure options for clearing an alert condition.

» Configure the syslog port.

 Select events to be alerted to.

» Enable or disable alerting.

» Configure SMTP (Simple Mail Transfer Protocol) settings and alert destinations.

» Enable or disable event collection.

» Manually clear an alert condition.

» View or download syslog files from the repository. These can be viewed by any text editor.
The configuration of event detection and alerting is done on the Appserver into which you are

logged. It is not necessary to select a system from the Support Tools > I nteractive M ode >
Select System menu.
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How to Use the Event Detection and Alert Menu

See also:

» About Event Collection, Event Detection, and Alerts (page 67)
» How to Configure Event Settings and Select Events (page 68)
» How to Configure and Enable or Disable Alerts (page 68)

» How to Enable or Disable Event Collection (page 69)

» How to Manually Clear an Event Condition (page 69)

» How to Use the History Tools (page 80)

How to Configure Event Settings and Select Events

Step 1

Step 2

Step 3

Step 4

Step 5

Use the Select Events menu to:
» Configure options for clearing the alert condition.
» Configure the syslog port.

» Select events for which you want to be alerted.

From the Dashboard menu, select Support Tools> Event Detection and Alert > Select Events.
In the Select Events screen, select one or more options for clearing the alert condition.

For a brief explanation of the options see About Event Collection, Event Detection, and Alerts
(page 67)

Enter a value for the syslog port (the default syslog port number is 514).

Select one or more events to be detected by selecting the corresponding check box. At least one
event must be selected or a warning message will be displayed.

Click Submit.

How to Configure and Enable or Disable Alerts

Use the Configure Alerts menu to:
» Enable or Disable alerting.
 Configure Simple Mail Transfer Protocol (SMTP) settings and alert destinations

« Select events for which you want to be alerted.
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Step 1

Step 2

Step 3

Step 4
Step 5
Step 6

Step 7

Step 8

How to Use the Event Detection and Alert Menu

From the Dashboard menu, select Support Tools > Event Detection and Alert > Configure
Alerts.

Select the Alerting Enabled checkbox.

If the checkbox is deselected, alerting will be disabled and the rest of the screen will be grayed
out preventing SMTP email settings and email destinations from being configured. The most
recent values entered will continue to be displayed, but any configuration changes made prior
to the checkbox being deselected will not be saved

Enter the SMTP Server name of IP address.

The maximum length for entering an SMTP server name or email address is 30 characters.
Enter the SMTP Port number (the default SMTP port is 25).

Optionally enter a From email name.

Enter the From email address.

Enter one or more destination email addresses. Enter each address on a separate line.

At least one destination address is required.

Click Submit.

If alerting is disabled, the configuration settings will be ignored.

How to Enable or Disable Event Collection

Step 1

Step 2

Use the Enable/Disable Event Collection menu to enable or disable event collection.

In the menu tree on the left of the Support Tools dashboard, select Event Detection and Alert
> Enable/Disable Event Collection

You may need to scroll horizontally to see the whole menu name.

Click the Event Collection button to enable or disable event collection. This is a toggle button
and will display Disable Event Collection if event collection is enabled and Enable Event
Collection if event collection is disabled.

How to Manually Clear an Event Condition

Step 1

Use the Clear Alert Condition menu to manually clear the alert condition.

In the menu tree on the left of the Support Tools dashboard, select Event Detection and Alert
> Clear Alert Condition
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How to Use the System Interrogate Screen

Step 2 Click Clear Alert Condition.

This button will be available even if there is no alert condition. In that case, clicking the button
has no effect.

How to Use the System Interrogate Screen

Use the System Interrogate tool to view information about the current system.

Note: This tool can be used in both I nter active M ode and Batch M ode. For additional details
on scheduling this tool to run in batch mode see Using Batch Mode (page 28). See below for
details between the different options available in Interactive Mode and Batch Mode for System
Interrogate.
Using System Interrogate you can:
« View system information on following:

— Operating system and hardware

— Cisco MCS Server

— SQL Server Information

— Web Server Information

— Cisco JTAPI Information

— ODBC Information

— Cisco Security Templates

— ICM 5.x 6.x or 7.x node

— Cisco Callmanager (CCM)

— Cisco Webview

— Cisco SNMP

— Cisco IPCC Express (CRS)

— Cisco Agent Desktop (CAD)

— Cisco Security Agent (CSA)

— The speed and dulex configuration for the NIC server along with recommended settings.
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How to Use the System Interrogate Screen
Note: This is only a small subset of the list of information that you can view. The type of
system information that can be retrieved depends upon the node type of the selected system.
All of the above categories are not present for every node.
» After Interrogating the system you can save the data to a file.
There are differences between the type of information that System Interrogate can retrieve

depending on whether it is running in Batch Mode or Interactive Mode.

In Batch Mode there is a fixed set of information that can be retrieved once selected for retrieval.
This information includes:

e OS

« CPU

« Memory

e Disk

» Windows HotFix

» Windows Domain

» Web Server (if present)

In Interactive Mode, the selected system is queried to determine which types of information are
available for retrieval. This information includes the type of information that can be retrieved

in batch mode and adds some additional types of information. See the table below for complete
details.

Table 3: Types of Information Retrieved from System Interrogate

Component & Sub-components Retrievable
only in
Interactive
Mode
Windows OS

« OS and Hardware Information
» OS and Hardware Information (additional)

» Dr. Watson Log File

Cisco MCS X
e OS Image

» OS Upgrade
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Component & Sub-components

Retrievable
only in
Interactive
Mode

*« OSInfo

» MSC Installation log files

Cisco Patches

 Cisco Application Patches

SQL Server Information
» SQL Server Registry Values

» SQL Server WMI Values

11S Web Server

o |IS Web Server

Cisco JTAPI Information

* Cisco JTAPI

ODBC Information

+ ODBC

Cisco Security Templates
» Security Hardening Settings

» Security Hardening Sections

Cisco ICM 5.x, 6.x, or 7.X

e ICM5.x, 6.%, or 7.X

Cisco ICM 4.6.2

« ICM4.6.2

Cisco IPCC Enterprise Web Administration
« Client Properties File

 Properties.xml file
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How to Use the System Interrogate Screen

Component & Sub-components Retrievable
only in
Interactive
Mode

» Cisco CCBU Support Tools HTTP Server (Tomcat) log files

» WebConfig log files

Cisco ICM/IPCC Agent Reskilling X

Client Properties File

Properties.xml file

Cisco CCBU Support Tools HTTP Server (Tomcat) log files

WebConfig log files

Cisco WebView X
» Jaguar log files

» ServletExec log files

Cisco SNMP

» Content Center SubAgent log files

» Management Service log files

» Management Server Instance log files
» Contact Center Trap Agent log files

» Native SubAgent Adapter log files

» Master Agent log files

Cisco CTIOS Server 5.x X

CTI Driver log files

CTI OS log files

NM log files

NMM log files

Cisco CTIOS Server 6.x X

o CTI Driver log files
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